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i What is ANFIS ?

= ANFIS stands for Adaptive Neural Fuzzy Inference System.

= Using a given input/output data set, the toolbox function
anfis constructs a fuzzy inference system (FIS) whose
membership function parameters are tuned (adjusted)
using either a backpropagation algorithm alone, or in
combination with a least squares type of method.

= This allows your fuzzy systems to learn from the data they
are modeling.



i ANFIS Background

= Algorithm defined by J.-S. Roger Jang in 1992

= Creates a fuzzy decision tree to classify the data into one of

2n (or pn) linear regression models to minimize the sum of
squared errors (SSE):

SSE =3 ef
J

= where:

= € is the error between the desired and the actual output

= p is the number of fuzzy partitions of each variable
= N is the number of input variables



i Model Learning

= The basic idea behind these neuro-adaptive learning
techniques is very simple:

= These techniques provide a method for the fuzzy modeling
procedure to learn information about a data set, in order to
compute the membership function parameters that best allow the
associated fuzzy inference system to track the given input/output
data.

= This learning method works similarly to that of neural networks.
= The Fuzzy Logic Toolbox function that accomplishes this

membership function parameter adjustment is called anfis.

= anfis can be accessed either from the command line, or through the
ANFIS Editor GUI.



i ANFIS Framework

= Like all MATLAB toolboxes,
the Fuzzy Logic Toolbox can
be customized. You can easily
inspect algorithms, modify
source code, and add your own
membership functions or
defuzzification techniques.
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i How to Start ANFIS

Start Matlab

= For non-GUI anfis, just type anfis on the command line of
Matlab.

= For ANFIS Editor GUI, just type anfisedit on the command
line of Matlab.
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i GUI Screenshot

1 - Load or save a fuzzy Sugeno system, or open new Sugeno system.
2 - Undo.

3 - Open or edit a FIS with any of the other GUISs.

4 - Plot region.

5 - Status of the number of inputs, outputs, input membership functions, and
output membership functions.

6 - After you generate or load a FIS, this button allows you to open a
graphical representation of its input/output structure.

7 - Test data against the FIS model. The plot appears in the plot region.

8 -Train FIS after setting optimization method, error tolerance, and number of
epochs. This generates error plots in the plot region.

9 - Load FIS or generate FIS from loaded data using your chosen number of
MFs and rules or fuzzy.

10 - Clear Data unloads the data set selected under Type: and clears the plot
region.

11 -Load either training, testing, or checking data from disk or workspace, or
load demo data. Data appears in the plot region.

12 -Testing data appears on the plot in blue as . .; Training data appears on
the plot in blue as 0 0; Checking data appears on the plot in blue as ++; FIS
output appears on the plot in red as **



i From GUI you can:

Load data (training, testing, and checkmg? by selecting appropriate
radio buttons in the Load data portion of the GUI and then clicking
Load Data... The loaded data is pIotted on the plot region.

= Generate an initial FIS model or load an initial FIS model using the
options in the Generate FIS portion of the GUI.

= View the FIS model structure once an initial FIS has been generated or
= |oaded by clicking the Structure button.

= Choose the FIS model parameter optimization method:
backpropagation or a mixture of backpropagation and least squares
(hybrid method).

= Choose the number of training epochs and the training error tolerance.
= Train the FIS model by clicking the Train Now button.

= This training adjusts the membership function parameters and plots
the training (and/or checking data) error plot(s) in the plot region.

= View the FIS model output versus the training, checking, or testing
data output by clicking the Test Now button.



Checking and Training

+

= To start training in ANFIS Editor GUI:

First, you need to have a training data set that contains desired
input/output data pairs of the target system to be modeled.

Sometimes you also want to have the optional testing data set that
can check the generalization capability of the resulting fuzzp
inference system, and/or a checking data set that helps with model
overfitting during the training.

Overfitting is accounted for by testing the FIS trained on the
training data against the checking data, and choosing the
membershiﬁ function parameters to be those associated with the
minimum checking error if these errors indicate model overfitting.

You will have to examine your training error plots fairly closely in
order to determine this.

Usually these training and checking data sets are collected based
on observations of the target system and are then stored in
separate files.
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i Example

Checking Data Helps Model Validation

= Loads similar training and checking data sets, only the
checking data set is corrupted by noise.

= Loading Data into the ANFIS Editor GUI from the
workspace:

« Load the training data sets: fuzexltrnData and
fuzex2trnData.

= Load the checking data sets: fuzexlchkData and
fuzex2chkData.

= Loading Data from command line (/oad filename.dat):
« Joad fuzexltrnData.dat
= Etc.

11



i Example (cont)

= To load the training data set:
= Select Type: Training; From: worksp. ; click Load Data...

é
npul vanahle nam=
I FurslbinlDiat=

Cancel | Ak |

= The training data appears in the plot in the center of the GUI as a
set of circles. *
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Example (cont)
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i Example (cont)

Next: click Checking in the Type column of the Load
data portion of the GUI to load fuzexichkData from
the workspace.

= This data appears in the GUI plot as p/usses
superimposed on the training data.

= The data set will be used to train a fuzzy system by
adjusting the membership function parameters that
best model this data.

= The next step is to specify an initial fuzzy inference
system for anfis to train. *

14



¢ AHNFIS Edibo

L ntitled

Bl Edt  Wiewm
Checking Cata (+++) — AHFIS Inlo, —
1 [~ __,_——__-___-
ok ) I | Rckincuts 1
oL L2 LA+ Hof oulpuls: 1
Tl H of inout nifs:
= + . o
& ply 4 # of check dats
= . pailz: 26
= + . or L
o % &1 Py
E-1 FPa o &
_— + 4~
pi i = e U e I
_1 1 1 1 1 1 1
0 5 10 15 20 25 A Clexr Pt |
data ==t index
—  Load dsta — | I Generat=Fl5 — 1 TranFlI5 — 1 TesztFS ]
Type: [ Clpeinn. b ethiod
~ Traming i Load kom dizk | babirid ﬂ Flal agaiat:
i i o v Tiari
- Testng dizk " |_nad fom woik.zp :Ell:ln:r TokErace: i raning data
Giid liti Testing dat=
% Checkng & worksn 1 patian E pochs: =
 Dero " Sub. clustering E (= Checking datz
LoadDatz . | CleaiDala | Gereiats FI5 . | Tirsith s ) F=0ilen |

check data lonaded

Help

| Cloze |

+++ Checking data

oo Training data

15



i Example (cont)

Initializing and Generating FIS:

= You can either initialize the FIS parameters to your own preference, or
if you do not have any preference for how you want the initial
membership functions to be parameterized, you can let anfis do this for
you.

Automatic FIS Structure Generation with ANFIS:

= To initialize your FIS using anfis Choose Grid partition, the default
partitioning method. There are two partition methods: grid partitioning
and subtractive clustering.

= Click on the Generate FIS button. This displays a menu from which
you can choose the number of membership functions, MFs, and the
type of input and output membership functions.

= Notice there are only two choices for the output membership function:
constant and linear. This limitation of output membership function
choices is because anfis only operates on Sugeno-type systems.
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i Example (cont)

= Fill in the entries as we've done below, and click OK.

—IMPUT
urnber of kFz: MF Type:
rirnf "
4 traEmf J
. g gauizzmf
T azzigh a different U
number of MFs to each of
input, uge spaces to Esigmf
seperate these numbers. e
—OUTPUT
MF Type: congtant j

Cancel | )4 |




i Example (cont)

Specifying Your Own Membership Functions for ANFIS:

Open the Edit membership functions menu item from
the View menu.

Add your desired membership functions (the custom
membership option will be disabled for anfis). The output
inembership functions must either be all constant or all
inear.

Select the Edit rules menu item in the View menu. Use
the Rule Editor to generate the rules.

Select the Edit FIS Properties menu item from the View
menhu. Nakme your FIS, and save it to either the workspace
or the disk.

Use the View menu to return to the ANFIS Editor GUI to
train the FIS.
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i Example (cont)

Viewing Your FIS Structure:

= After you generate the FIS, you can view the model
structure by clicking the Structure button in the middle of
the right side of the GUI.

= A new GUI appears, as follows

-
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i Example (cont)

Node labels - for
example, leftmost
node is the
input node.

Return to other open GUIs
using the Window menu.
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i Example (cont)

ANFIS Training

= The two anfis parameter optimization method options
available for FIS training.
=« hybrid (the default, mixed least squares and
backpropagation)
= backpropa (backpropagation).
= The Error Tolerance is used to create a training stopping
criterion, which is related to the error size. The training will
stop after the training data error remains within this
tolerance. This is best left set to 0 if you don’t know how
your training error is going to behave.
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i Example (cont)

= To start the training
=« Leave the optimization method at hybrid.

=« Set the number of training epochs to 40, under the
Epochs listing on the GUI (the default value is 3).

= Select Train Now.
= The following should appear on your screen.

.

22



& AHFIS Edilor

LI ntitled

s [FOINING BIFOT

.. Checking error

Bl Edt  Wiew
Training Error — ANFIS [nlo. —
016 -
I R R ATy B of inpuk 1
014 e, Ler" H of oulpuls: 1
i TR " H of inout nfs:
4
= Ty, :
Ewi2p Fp,
¥ o
-
o *y +
i
+
. . . . . L thesas Shuciue |
nE Clear Pict |
0 L3 10 15 200 25 20 a5 iy
Epoch=
Load d=ta —  Eenerats FIS — 1 [ TranFI5 — 1 TeztFlsS ]
Type: Fiom: O ptim. b ethod
~ Traiing " Load from cizk |I*'|_|,-'I:|ri|:| ﬂ Flat 2gaiat:
 Testng T disk i Load from woikzp Enor Tolkerarce: " Tiaring data
& Giid paitit [0 ™ Testing data
+ Checkna & workzp = e m? Epochs: . r._:|
 Demo Sub. clusteing [ 40 Checking data
Load Diatz . | CleaiDala | Geneiats FIS | Trzin Mow | Test Mo |

Epoch 4 errar- 0 DE2462 Helo | Clnze |

23




i Example (cont)

Testing Your Data Against the Trained FIS.

= To test your FIS against the checking data, click Checking

data in the Test FIS portion of the GUI, and click Test
Now.

= Now when you test the checking data against the FIS it
looks pretty good.

y
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Exambple (cont)
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i Some ANFIS Tips

Tip 1 If you are ever loading data into anfis after clearing previously
loaded data, you must make sure that the newly loaded data sets have
the same number of inputs as the previously loaded ones did.
Otherwise, you will have to start a new anfisedit session from the
command line.

Tip 2 If you don't want to use the checking data option of anfis, don't
load any checking data before you train the FIS. If you decide to
retrain your FIS with no checking data, you can unload the checking
data in one of two ways. One method is to click the Checking radio
button in the Load data portion of the GUI and then click Clear Data
to unload the checking data. The other method you can use is to close
the GUI and go to the command line and retype anfisedit. In this case
you will have to reload the training data. After clearing the data, you
will need to regenerate your FIS. Once the FIS is generated, you can
use your first training experience to decide on the number of training
epochs you want for the second round of training.
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Matlab - $500.00

Matlab Compiler - $500.00
Simulink - $500.00

Fuzzy Toolbox - $200.00

Total: Just $1,700.00 for academic use only
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